Introduction to ArcGIS  (Plano Example for  ArcGIS version 9.2)


8/28/2007
Ron Briggs – UT-Dallas  Program in Geographic Information Sciences 

Opening and Getting Going (G & K Tutorial #1)  

For instructions on logging on in the Green labs, go to # 23 below.

For detail on new capabilities in 9.2, go to: P:\ArcGIS_9-Help\ESRI_Library_9\ Whats_New_In_ArcGIS_92.pdf
1. ArcGIS


ArcGIS is only available in the Social Science lab which runs Windows XP


ArcGis Desktop comprises two primary modules or programs: 



ArcMap: for data display, map production, spatial analysis, data editing



ArcCatalog: for data management and preview



(ArcToolbox, used for data conversions and analysis, is now a window in ArcMap/ArcCatalog)

The capabilities available to you in these modules depend on the ArcGIS ‘level’ of your license



ArcView:  viewing, map production, spatial analysis, basic editing



ArcEditor: ArcView, plus specialized editing



ArcInfo: above, plus special analyses and command-line ArcGIS Workstation (old ArcInfo v.7)


Extensions add  capabilities for special applications: Spatial Analyst, 3D Analyst, Geostatistics Analyst

2. From the Start button, select Programs /ArcGIS/ArcMap, 

                     or Single-click the ArcMap Icon in ArcCatalog to launch ArcMap

· When ArcMap Starts you will get a “SPLASH” screen 3 options for starting to use ArcMap

· a new, empty  map

· a template

· an existing map.

· Select “A new empty map” and click the OK button

3. ArcMap is fully Microsoft Windows compliant. For example:

To close ArcMap, select : File, Exit, or click the X button in the top right.
As with many MS applications, right-clicks provide access to many capabilities. 
4. Toolbars

Hide and show toolbars from the View menu

· Click View and point to Toolbars.

· Check a toolbar to show it.

· Uncheck a toolbar to hide it.

· For now,  show only Main Menu, Standard, Tools, and Layout toolbars

Docking Toolbars

Any toolbar can be docked at the top or bottom or to the left or right side of the ArcMap or ArcCatalog windows. Alternatively, toolbars can float on the desktop while functioning as part of the application. When you dock a toolbar, it is moved and resized with the application’s window. To prevent a toolbar from docking, hold down the Ctrl key while dragging it. To move a docked toolbar, grab it by the vertical line at the left side.

· Play with the tool bars by docking, undocking, repositioning, etc.

Accessing toolbar list

You can also access the toolbars list without using the View menu. Simply right-click within  the grey area of existing toolbars, or the pull down menus

Be patient!. Give software time to complete its work before clicking again! 

LOCATING A DAY CARE CENTER IN PLANO

Get Data into ArcMap and Examine it (G & K #5)
10.1 Import  spatial layers of data 

· Click Add Data icon [image: image1.png]


  (or select File/Add Data pull down) —the Add Data window opens

· Navigate to the location of  the data: P:\briggs\g6381\avintro
· If P:\ not listed, click Connect to Folder  [image: image2.png]


  and select data on ‘eppsgreen.utdallas.edu’ (P:), For direct connect, click expansion boxes (+) for  briggs, select g6381, then click OK
· Multiple selections should appear: note how the type of icon reflects the type of data

· Select the following four layers by holding down ctrl key and clicking  on  each



art.shp, citybnd.shp,   tracts.shp, trans.shp
· click  Add button, and four items appear in the Table of Contents window of  ArcMap  

(henceforth in this document T of C refers to Table of Contents)


and are displayed in the Data View  on the right

      Do not be concerned by the message: One or more layers is missing spatial information. Click to close it.

10.2  ArcMap Major Features

· Left Window is the Table of Contents (TofC) tree. Two formats controlled by Tab at bottom.

· Sources tab lists (and allows you to update) source of data: looks like Windows Explorer 

· Display tab controls map display and legend creation: looks like a map legend

· Selection tab controls which layers are “selected from” when you use selection tools
(if there is no TofC, go to pull down menus and select View/Table of Contents) 

· Right Window is Spatial Display. Again, two formats, controlled by icons at bottom

· Layout View (Sheet icon) displays “map layout” (for printing hard copy), potentially with multiple ‘data frames’ each containing a different map (or other graphic)

· Data View (Globe icon) displays a single frame (equivalent to a View in ArcView)

The third icon at the bottom (a double-arrow)  is a refresh button, to redraw  the display 

      Before continuing, be sure that:

· Globe icon is selected at the bottom of the Data View window.

· Display tab is selected  at the bottom of the Table of Contents (T of C) window: 

10.3 Looking at the TofC 




Click on check boxes [image: image3.png]


to the immediate left of each item in TofC:



--this turns the layers on and off (displayed or not displayed)



--after playing with these, leave tracts on and all others off


Click  the expansion box [image: image4.png]


 to the far left of each item in TofC

--negative symbol turns to a plus

--legend icon (or category patches)  below the item name disappear  

Click  to the right of an item in TofC:



--its entry is highlighted in blue  to indicate this is the “selected” or “active” layer



--all actions pertaining to a  layer will be applied to this one




--multiple layers can be made active by holding ctrl key when clicking 

10.4 Play with map in Data View  window using zoom icons and tools 


[image: image5.png]


4 inward arrows: zoom in  (make bigger) by 2x    [image: image6.png]


4 outward arrows: zoom out (make smaller) 2x  

[image: image7.png]


magnifier (zoom in): draw box, and area in box is zoomed in to (more detail) 

[image: image8.png]


reducer (zoom out): draw box, and area in box is zoomed out to (less detail) 


[image: image9.png]


 pan tool: grabs layer and moves it around the screen 


[image: image10.png]-



 return to  previous extent (the area displayed)
[image: image11.png]


 zoom out to extent of all layers   ('gets you back to base') 


(“extent” is  the area covered by the map or layer)
   With 9.2, the mouse wheel can also be used for zooming. Use of CTRL and Shift provide additional  options.
When finished  zooming, be sure to return to standard mouse “pointer”  (diagonal arrowhead icon)

10.5 Set Coordinates  for the Data Frame

X,Y coordinates for pointer location are shown in lower right  along with the units (feet in this case).

If this says Unknown you will need to tell ArcGIS what units (feet, miles, etc) the data is in.

In this case, data units are known since the data’s projection system was recorded with the data.
Right click an empty area within the Data View  window  and select Properties –Data Frame Properties box opens and there are two approaches you can take:
         (1) Select General tab,  and in the Units box: 

Click down arrow on Map Units box and select feet—these are the actual  units data is recorded in.

Click down arrow on Display Units box and select feet—these are units ArcMap reports info in.

Click OK--note that scale now displays

         ArcMap now knows the data units or metric, thus can do calculations, measurements, etc..

     Or (2) Select Coordinate System tab, and in the Select a Coordinate System box specify it.


For example, if data is State Plane, click the expansion (+) box next to Predefined



Click the expansion box (+) next to Projected Coordinate System



Click expansion box (+) next to State Plane





Click expansion box (+) next to NAD1983 Feet





Select NAD83 StatePlane Texas North  Central FIPS 4202 (Feet)

           

Click Apply button, click OK button


ArcMap now knows units and the coordinate system of the data, thus can also re-project it if desired.

It is important that units and projection are known, otherwise will cause problems e.g. scale bars will not work.

I advise always using ArcCatalog first to define the projection in the metadata, then it will be known by ArcMap.  
11.1 Import non-spatial data tables 

· Click Add Data icon (black plus)  (or select File/Add Data pull down) —the Add Data window opens

· If necessary, click Connect to Folder icon (yellow arrow) and select  P: drive

· If necessary, navigate to the location of  the data: P:\briggs\g6381\avintro
· Multiple selections should appear: note how the type of icon reflects the type of data file

· Select the following two  by holding down ctrl key and clicking  on  each



Childcar.dbf  (a list of child care centers in Plano)
   

planocen.dbf  (Plano census tract data)



(be sure that you get the ones  with .dbf extension)

· click  Add button, and two items appear in the Table of Contents window of  ArcMap  

Note that the TofC window switches to the Source Tab since these are tables with no explicit spatial info so they cannot be displayed. Click the Display tab—the tables are not listed under here. 

· Note: ArcMap will read tables in dbf, csv (comma delimited text files), INFO and MS Access format. Use Excel to convert your tables to dbf or csv. Next release (Version 9.2) will directly support Excel.
11.2 Examine the table data 

· Right click the table name in TofC--e.g. childcar—and select Open
Attributes of childcar  window opens and displays the data

(if childcar doesn’t show in TofC, click Source tab below Tof C window)

· Scroll thru the data. You can do many things to this table and its underlying file either by:

· Right-clicking on the heading (variable name) at the top of a column

· Clicking  the Options button at the bottom of the table   


Close childcar.txt table by clicking X box in upper right corner (won't be needed till later)

11.3 Examine table data for Spatial layer

You can also examine the table underlying spatial layers. Do this for tracts layer.

· Right click tracts  in Tof C and select Open—Attributes of tracts  window opens and displays the data

· FID (feature ID) and Shape fields will always be present, as should at least one other identifier field (e.g tracts). Never delete or change any of these!

· Shape field specifies spatial format of the data (point, line, polygon)

· Note that there is no real attribute data describing these spatial features. We will remedy this. 

It’s wise to save a copy of you work now, and also after other steps, in case something crashes!! 


--See Section 20 for instructions on saving


--use amended name each time you save e.g. mymapA, mymapB, mymapC etc.
(Section saved as …… P:\briggs\g6381\avintro\mxds\avintroA.mxd)

Link Data and Make Map  (G & K  #2)
12.1  Link demographic data to census tract geography 
In TofC, right-click tracts  layer  and select Join and Relates/Join 

 note:  you must begin with a spatial layer, not a table
· In What do you want to join to this layer? box, select

· Join attributes from a table 

· In Box 1, select the field (variable) Tract  

· In Box 2, select the table  Planocen 

· In Box 3, select the field Tract
· Click OK button 

In essence, this will append the census data in planocen to the tract outlines in tracts, using the common variable tract. The common variable must have same values for corresponding features (rows), but does not need to have same name, although it does in this case.

· To see this, right-click tracts  layer in TofC and select Open Attribute table

· Note how data from planocen has been appended

· Each variable name now has two parts with the first part indicating the source table

· Close the window

12.2. Making a thematic (choropleth) map  

Right click tracts layer in Tof C, select Properties, and click  Symbology tab  

The Show box lists the major  types of symbology displays available 


Features/single symbol,  the default currently selected (all polygon features colored the same) 


Click Quantities: four options are listed—select Graduated color  


In Fields box 

click  down arrow on Value line, scroll down, and select planocen.Agelt_06 




--this select the variable (field) to be mapped 

--5 classes displayed (uses 'natural breaks'  as default to select class breakpoints)



you may also select a Normalization field




--value field would then be divided by normalization field values




--e.g. if normalization field was All_kids, you would be mapping proportion below 6


   To select  your preference of colors, click Color Ramps down arrow  (use  a blue ramp)

   To see  analyses of  the classification (histogram, etc..) click Classify button in the Symbology window .
    For classification methods, click Classify button and then down arrow on Method line: 6 available



Manual:  select the category bondaries yourself

Natural Breaks (default): uses clusters and breaks in data



Equal Interval: data range divided into classes of equal width, based on # of classes you select



Defined Width: again equal width classes, but number of classes based on width you select



Quantile: each class contains equal number (quantity) of observations


Standard Deviation: classes based on the selected number of SDs from the mean


Click Apply button to see the effect on map. Click OK  to close Layer Properties window 

Voila--we have a map showing location of 0-6 year olds. Technically, its called a choropleth map.  

(if no map, click  on tick box next to Tracts in T of C—it must have tic mark to display map)

(Section saved as … P:\briggs\g6381\avintro\avintro2000_old/amintroB.mxd/))

12.3 Control for differing sizes of geographic units --  map Density  under 6   

The first layer gave us counts. However, there is always a problem with drawing choropleth maps based on raw counts because the count in part depends on the simple geographical size (area) of each tract. To counteract this, we should also look at density (counts per square mile). 

· Create a copy of tracts layer

· right click on tracts in T of C and select Copy

· right click on Layers in TofC and select Paste Layer
· to prevent confusion, click on tracts layer name in TofC, click again to get edit box, and change name to Kids-density
· change data: Right click tracts layer copy at top in Tof C, select Properties, and click  Symbology tab  

· In Show  box, click Quantities and select Graduated color  

· In Fields box  click  down arrow on Normalization  line, scroll, & select tracts.Area_sqmi
· Value field (age_lt6) is divided by Normalization field (area) to calculate “density” 

(alternatively, for Value field choose Planocen.denle_06, with Normalization set at None)  

· 5 classes displayed 

· turn density layer on and off to compare with counts: density much better. Use it!

12.4 Add info on income: 
· change counts layer to display median family income instead of counts of kids
· right click the lower tracts layer (displaying counts), select Properties, and click  Symbology tab    

· change the Value field to Planocen.MEDFAMINC  and click apply

· lets just show high income (above $100,000)

· In the Classes box, enter 2 ---data  is reclassified into 2 classes

· Click Classify button—Classification window opens

· In  Break Values box, change 1st number to 100000 which changes the class boundary

(or in the histogram, drag the colored class boundary line to 100000) 

· click OK button and you are returned to the layer properties window

· In the Layer properties window, click in the label  column

· Make the label for the first line: $100,000 or less
· make the label for the second line: Above $100,000
· to prevent confusion, click on tracts layer name in TofC, click again to get edit box, and change name to Income
· click apply button and the map is redrawn
· but we still can’t see both  income and density at the same time!! 

· Change the shading for the two patterns 

· In TofC click the colored symbol box for below $100,000—Symbol selector window opens

· Select Hollow and click OK

· In TofC click the colored symbol box for above $100,000—Symbol selector window opens

· Scroll down and select 10% Simple hatch
· Click Properties button—Symbol Properties editor window opens

· Click Line button, and in Options box set Width to 1.5

· Click OK buttons to exit from all these windows
· Finally, click the Source tab (under T of C window) and drag Income layer to the top.
Net effect: tracts with high income highlighted (with bold stripe), yet still see underlying density of kids.

 (Section saved as … P:\briggs\g6381\avintro\avintro2000_old/amintroB.mxd/))
Locate Existing Day Care Centers on Map Using Geocoding  (G & K # 7) 
13.0 Geocoding is a four part process:

1. Create an Address Locator (Geocoding Service) 
2. Load the Address Locator  into ArcMap—there can be several.
3. Geocode a specified address file, in batch, using a selected address locator 
4. Interactively fix individual problems for addresses which didn’t match

(each step can also be done via tools in ArcToolbox)

13.1  Create Address Locator

Before you can geocode in ArcMap, you must have an Address Locator available.


         Essentially this is a “reference data set” or “streets file” containing 



street spatial network



Street names



Address ranges (house numbers) along each block


(if necessary), Zone identifier such as zip code, city name, or city code

         which has been processed for  geocoding.
You create this using ArcToolbox (version 9.2) or ArcCatalog (version 9.1)

(See Section 22 for creating Address Locator with version 9.1)
Note:  in 9.2, the Address Locator file, once created, includes the street data. In 9.1 and earlier, it does not, so the Address Locator and the original street data must be kept in the same folder. 
Click the [image: image12.png]


 icon to open ArcToolbox and go to ArcToolbox>Geocoding Tools>Create Address locator


--double click Create Address locator tool to open its dialog
Address Locator Style: click folder icon to open Select Address Locator Style window, and select US Streets as the style to use  (click Help button for description of style types)

Reference Data:  click folder icon  [image: image13.png]W



,  navigate to folder  select trans  file



(do not use down arrow—it seems to have a bug)


    Click in Role column and select Primary (red icons should then disappear)
Field Map:  check that variable names  (from reference file) shown in right window (Alias Name), contain data required in left window (Field Name)

Output Address Locator:  specify name and location for address locator file e.g. Plano_AL 
Click OK.  When process finishes, scan dialog for any error messages. If none,  click Close
13.2 Add a Geocoding Service to ArcMap

· Open ArcMap (if not already open)

· Select Tools/Geocoding and select Geocode  Addresses. The Choose an Address Locator  dialog opens

(you can also select ../Address Locator Manager  )

· If the Address locator you created is listed, highlight it, and click  OK

· If it does not, click Add button and Add Address Locator  browser box opens

· Navigate to where you saved the address locator or go to P:\briggs\g6381\avintro
· Plano_AL or Plano_07_US_Streets  should display--double click to select it 
· You return to Choose an Address Locator dialog which should now contain Plano_07_US_Streets   . Highlight it and click OK
13.3 Geocoding a Set of Addresses 

· Geocode Addresses: Plano_AL or Plano_07_US_Streets  dialog box should be open
· Be sure childcar is listed as the Address table to be geocoded

· Street or Intersections should specify STREET_ADD

· In Output shape file or feature class box  you must specify an appropriate location and name for geocoding results file.  

· If necessary, click browser button [image: image14.png]W




· In Look in box, navigate to appropriate disk and folder e.g. My Documents
· In Save as File type, specify shapefile

· In Name box, give name (e.g. Daycare_Geocode), and click Save
· If you want special options, click Geocoding Options button. You can, for instance,  include XY coordinates for your addresses in the geocoding file which is  created.

· Click OK button and geocode process starts

· When the geocoding process ends:

· A Geocoding Results layer is added to T of C

· Locations are displayed in the Data Display window

· Review/Rematch window provide results from geocode process. You can

· Click Done button if you are satisfied with results

· Click Match Interactively to attempt to locate unmatched addresses (see next)

13.4 Examine addresses which didn’t match 



· In the Interactive Review window:

· Top box displays unmatched records from the list of Daycares (should be 3)

· The middle part displays address info from the line highlighted in the top box

· As recorded in the file of addresses (in Street or Intersection box)

· Type any desired corrections here (none in our case) and click Modify to invoke

· As standardized by ArcMap  

· note how PKWY standardized to PKY

Any changes made here will be saved in the ARC_Street field in the geocoding file

· The Bottom box displays possible candidates from the reference file

· If desired, click Zoom to: Candidates to zoom the display to the candidates

· Problem often no exact address range match in reference file  (or missing direction prefix: E/W)
· Click on  LeftFrom or RightFrom column heading to sort by address range

· Search  fields to find closest address range

· Click on  line with closest address range to highlight it, 

· click Match button, 

· In the top box, Status changes to M  (or matched) for this line, and a street address entry in Match_adr column is created
· To work on another record, in top box click the grey tab at the start of the row 
· If  no candidates appear in the bottom box, try:
· In  Street or Intersection box, remove the street number and click Modify 

(if an Edit Standardize box opens, simply close it)

· Repeat for all unmatched  entries, then click Close button to close Interactive Review  

· Review/Rematch Addresses window reappears with modified results

· There are no “unmatched” records now

· Click Done button. We are done geocoding.  

In essence we have added explicit spatial information to the implicit locations in childcar.dbf

Select Site for New Daycare

14.1 Analyze the Results


Locate in north central Plano: High density under 6, relatively high incomes


Relatively few existing centers.

14.2 Consider additional constraints  e.g. zoning
Use Add Data icon and bring in the layer zone_sf.shp  (in P:\briggs\g6381\avintro)



Double click the color patch for this layer and change its color to red
--cannot locate in these areas

If you want to see your other other data “through” the zoning layer, you can make it “transparent”:



Go to View/Toolbars and open the Effects toolbar



Be sure  zone_sf  is displayed in the Layer box



Click the “water jug” icon [image: image15.png]


 and set the slider at around 75%

14.3 Select and Show Location  (Chap 18c)


· Locate the Drawing toolbar, probably along the bottom of the ArcMap display 

· (If necessary, go to View/Toolbar pull down menu  & click next to  Draw  to open it.)

· Click the down arrow next to the rectangle icon and select the blue dot graphics dot tool

· Move pointer to desired location in South Central area  and click once

· symbol  is drawn,  and object selection 'handles' (surrounding squares) show

· (if you make a mistake, click on object to select it  ['handles' show], then press delete key)

· Customize Location Symbol

· Double click the symbol in your View—Properties box appears
· Customize symbol as desired

· Note:  the location symbol used here is a graphic  (no underlying data set) which is fundamentally different from the day care layer which has an underlying data table.

Spatial Filtering Approach

15. Perform Spatial Filtering   (see Ormsby Chap 10 for a more extensive example)
The operation performed above was fundamentally a visual analysis. We can create a more formal modeling process by successively narrowing our location. This process is referred to as spatial filtering 

Go to Selection/Select by Attributes pull down menu.


In Layer: box, select kids-density  (or Tracts if not renamed previously)
 
In  “SELECT *FROM tracts_PLANOCEN WHERE” box

build a query by double clicking variable names in top box and single clicking operators:



"PLANOCEN.DEN_LE_06" > 600 AND "PLANOCEN.MEDFAMINC" > 100000



Click OK 

This is nothing more than a standard database selection, but with the results displayed visually. We can clearly see the high density/high income tracts outlined in light blue
To see some true GIS analytical capability, click the ArcToolbox icon [image: image16.png]


  and navigate to 


ArcToolbox/Analysis Tools/Overlay/Erase  and double click—the Erase dialog window opens



For Input Features box:  drag the kids layer from TofC 



For Erase Features box: Drag zone_sf  
On Output Feature Class line, click Browse button and navigate to My Documents (or similar) and name file as dc_site or similar.



Click OK.  When this geoprocessing operation completes, click the Close button.



(Note:  you cannot do this at home. It requires ArcInfo level of capability.)

The processing was applied only to the selected census tracts, and within these,  it identified all areas “outside”  (not within) the sf_zone (erase) layer. 
Turn off the zone_sf layer

Turn on the new dc_sites layer and make its color green 


--these are the locations areas which meet your filtering criteria 
 (Section saved as … P:\briggs\g6381\avintro\mxds\avintroC.mxd)

(Section saved as … P:\briggs\g6381\avintro\mxds\avintroC.mxd)

Customize  T of C and Data View  
16.1 Order of drawing  

· Click the Display mode tab under  the TofC (you can’t do this in Source mode)

· click on citybnd layer in TofC, hold down mouse button, and drag to top 

· oops--everything disappeared!

· moral:  order in table of contents determines order drawn: bottom to top; top is on top

· in T of C, click symbol box for citybnd layer—Symbol selector window opens 

· select Hollow for color

· enter 2 for Outline width

· click Outline color and make a selection

16.2 Customize Daycare Layer 

· Show more meaningful name in TofC

· Click Geocoding Layer once to select it. Click a second time to get edit box: 

· Type in name such as Daycare Centers 

· Change color/style of symbol

· Right click on symbol for daycares in T of C—color palette appears

· Left click on symbol for daycares in TofC—Symbol Selector window opens

· Many customization options available

· E.g. click More Symbols button and list of symbol sets appears--select Civic 

· Additional symbols are loaded below standard set—select an alternative e.g school 3



16.3 Customize Choropleth Layers 

· Show more meaningful name in TofC (and, later, in legend on printed map)

· Click heading planocen.AGELT_06  once to select it. Click a second time to get edit box: 

· Type in more descriptive name e.g. Density of Kids under 6 years old

· Repeat for Income layer

· Use whole numbers for count categories

· Right click “tracts” line for the density of kids layer and select Properties. 

· Click Symbology tab (if not selected), and click Classify button

· In the Break Values box, type the follow numbers 150, 300, 450, 600


Click OK, and then Apply button


Be sure that Labels are appropriate for the actual value Ranges. Modify as needed/desired.
(Section saved as …… P:\briggs\g6381\avintro\mxds\avintroD.mxd)

16.4 Change other titles and symbology as desiried:  e.g. for Streets (trans) and Major Arterials (art)

Creating a Layout  (G & K #3) 
16.1 Creating a Layout  for Printing 

· Click the page icon at the bottom of the Display View---View changes from Data to Layout format 

· Outer rectangle represents paper sheet—a virtual page  

· Dotted line (if present) shows allowable print area
· keep all your drawing within this boundary!   

· note rulers,  and pointer position in inches at bottom right of display

· Always begin by setting the layout properties---right click in the area beyond the page rectangle 

· Select Page and Print Setup
· Select your printer first, since this constrains layout size, etc..

· Note the two boxes:  upper  is for Printer setup, lower  establishes Map Size, 

· Click box for Use Printer Paper Settings to automatically keep the two ‘in sync’

· Be sure the printer and paper size you wish to print to is correct

· If you change this later it can mess up your layout!

· Set Orientation to Landscape

· Change Layout option allows you to select various pre-defined layouts

· We will use the default normal template

· Click cancel button if  the Select Template window is open

· Insert scale bar: 

· go to Insert pull down menu and select Scale bar; 

· make selection from style window (eg. the top one) 
· Select appropriate unit--miles--and click  OK
· scale bar frame is added to map; grab it and move to appropriate location

· Moving and Resizing Data Frames: The Plano map, in the center of layout, is called a “data frame”

· left click once within this frame--- “object handles” appear in light blue and the pointer changes

· You can reposition the frame and/or change its size (use pointer to grab a corner and drag) 

· Note how the scale changes as you re-size the data frame, but display will always be “geographically” correct

· You can have multiple data frames in a layout, if desired (see below)

· You can do the same thing with the scale bar: left click and reposition and resize as desired

· Inserting other Map Elements: go to Insert pull down menu and examine list of objects you can insert

· Practice inserting objects as desired: north arrow, legend, title, neatline boxes, etc.

· As you insert these, you can set their characteristics, some via “wizards”, others via tabbed windows
· Changing characteristics of existing map elements after insertion:

· The same customization options which appear when you first insert an element are also available by

· double-clicking the map element,  or if that doesn’t work

· right-clicking the map element and selecting Properties

· If you right click a map element various control options are available for copying, nudging, aligning

· For example, customizing the Legend is often necessary

· Double click the legend (assuming one has been added already)

· Legend tab: Change legend title from Legend to, for example, Legend for Day Care Analysis, or remove check in Show box so that no legend title is displayed. 
· Items tab: controls which items from TofC (map layers) to show as legend items, and how to display 
· For display options, select a legend item then click Style button. You can control 
Legend Title,  Layer name  (e.g tracts), Heading (planocen.agelt_06), descriptions ($100,000)
· The actual wording itself must be set first in TofC, or for descriptions, via Symbology tab 

· Placing Map elements on top of each other is OK, but one may hide another or make selection difficult, so

· Right click, select order, and then   send  back   or   bring forward     to achieve desired display

· You may need to do this in order to select map elements for customization

· Zooming the Layout and Using the Layout Toolbar

· The Layout toolbar allows you to zoom into the layout for more detailed work

· If Layout tool bar is not available, go to View/Toolbar pull down menu and select it
· The first icon is a magnifier over a  rectangle—don’t confuse this with the simple magnifier alone on the data frame tool bar (which is still available, but should not generally be used, in layout)
· Scan your mouse over the icons on the Layout toolbar to see what they do
· The 6th icon, Zoom to Whole Page, is very useful if you have zoomed in

(Section saved as …… P:\briggs\g6381\avintro\mxds\avintroE.mxd)

18. Using Layouts to Manage Multiple Data Views (used in Exercise 2)
Layouts can contain multiple Data Frames, or maps.  Often we want to print multiple “maps” on one page.

Alternatively, we can think of these data frames  as  “Data Views”  and the layout can be thought of simply as a way of organizing or managing these different views, rather than for creating hard-copy printout 

When you change the display from Layout View to Data View (by clicking the bottom globe icon), only one data frame is displayed—the active frame. You can work on that, and then switch to another frame to work on it.

· Go to File/Open and select the  am8introD.mxd  map document

· Remove the scale bar by left clicking to select it  and press delete key on your keyboard 

· Resize the Plano map by left clicking so that its blue object handles appear, and drag it to ¼ size

· Make a copy of  a map frame by:

· Right click on the Plano map and select Copy
· Right click again and select Paste
· Use left mouse button to drag the copy to its own location

· We know have two map frames

· Remove layers from one frame by:

· Right clicking the layer (e.g. Density below 6) in TofC and selecting Remove
· This only removes the data from the display: its doesn’t delete the underlying file

· Name the frames in the T of C so you know which is which 

· Click a Layers line in TofC so that its highlighted in blue

· Click the word Layers—an edit box should appear around the word. 

· Type Plano Kids (if it’s the frame with # and Density of kids)

· Type Plano Daycares (if it’s the frame just with daycares)

· Repeat for the other  Layer

· Selecting an Active map frame

·  Click on one of the frames  in the layout window

· dashed lines appear around its frame box

· its name should be bold in TofC

· If you get dashed lines around more than one frame or correct name isn’t bold in  Tof C (bugs!)

· Click the Refresh icon (double arrows below the Data View window)—display should redraw

· Click Display or Source tabs below TofC to redraw the TofC

· To work on the active  data frame 

· click the globe icon below the Display window

· display changes to Data View and the  active frame is displayed

· this is where you would normally work on that data set
· use tool to zoom in 
· click Layout icon (looks like a page) to return to layout view
· note that the frame now shows the zoomed view
· To add an empty data frame (into which you can then load data)
· Use  Insert/ Data Frame pull down menu 
Saving 

20.1 Saving Map Documents

· Select File/Save as from pull down menu and specify a location (e.g.  a:\) and file name e.g.  amintroA

· As with all computer applications, be sure to Save  on a regular basis as you work. 
· It is highly advisable also to use Save a copy on a regular basis and  specify  an amended name each time e.g. mymapB, mymapC, etc. Files can become corrupt and you don’t want to lose all your work reliant on one saved document!  
· When you use File/Open to load this document, ArcMap will open exactly as you saved it,  providing all files referenced by the map document are still present and in the same location.Your work is saved as a Map document with an extension of .mxd. These  are  binary files which cannot be edited. 
· See #24 below for discussion of compatibility between map documents from different versions of ArcGIS
20.2 What’s in a Map document?

Its critical to realize that a map document contains only references (or pointers) to data files, not the data files themselves. If you move the files, or use a different computer, and then try to open the map document, ArcMap may not be able to find the data files. A yellow exclamation mark will appear next to ‘lost’ files in the TofC. 

To specify the new location:

· Right click on layer in the T of C, and select  Data/Set data source

—navigate to the new source and click add

---all files in that folder with corresponding names will be automatically located 

To find where ArcMap is looking for data:

· Right click the spatial layer (not a table) in the T of C, and click the Source tab in the Properties box

--the Data Source box gives you basic info about the layer including its directory path and file name

--you can also change location from here by clicking the Set Data Source button  

Alternatively, under Source tab of TofC, you can  left-click the file source name and enter its new location directly. 
Until you get comfortable with map documents, it’s probably best to work in one place only (in the lab or at home) and not try to move files between two places. Also, see Section #24 for major issue.
20.3 File Storage at UTD 

You may 

(1) save your  maps directly to a flash drive (use USB ports on CPU in 3.602) or 

(2) save to your space on the network drive H;\. This can be accessed from  any machine  on campus but space is limited (about 50MB) and is also used for your campus e-mail (if you use UTD e-mail)
(3) save in My Documents . Because you have your own NetID logon, this is private but you must come back to the same machine to access the files. Also, it is not backed-up. 

(4) Save in My Documents and then copy the entire directory to a flash drive or to a recordable CD before leaving

(5) For more advanced classes you may be given additional network storage space on a GIS server.
  Remember to copy  before going home if you worked from the c: drive.

Printing and Displaying in other Software
21. 1 Printing in Green Lab 


You must supply your own paper.

Select the item you want to print by choosing either  Data View or Layout 



From the File pull down menu, select Print Preview 



--check that the page layout, etc.. is what you want,



--check that the correct printer is selected (should reference the lab room number)

--click the Print button
21.2  Printing Elsewhere


In ArcMap go to File/Export Map.   Under Save as Type, select .pdf , and Save file

The saved file can be printed on any computer with Adobe Acrobat Reader (free) installed.


If you do not obtain satisfactory results: 

--Go to  File/Export Map: click the Options selection at the very bottom and set parameters as desired; use at least 300dpi; also, under Format tab, select Embed All Document Fonts
--Alternatively, Go to File/Page and Print Setup:  select Adobe PDF as your printer, then click Properties to set  the various options. (I don’t know if this differs from Export!) 
21.3  Displaying a map in PowerPoint or similar


In ArcMap go to File/Export Map.   Under Save as Type, select .jpeg  and Save file



--as in #21.2, you may need to click Options and set resolution, etc.. 

In Powerpoint (or Word, etc..), use Insert/Picture/From File and browse to the saved .jpeg file

21.4 Printing problems


Successful printing can depend on the printer and the drivers available.


You may have to adjust the print properties to obtain a good print. 

22  Creating an Address Locator  in Version 9.1.  (See Section 13 for  9.2)
Before you can geocode in ArcMap, you must have an Address Locator available.


Essentially this is a “reference data set” or “streets file” containing 



street spatial network



Street names



Address ranges (house numbers) along each block


which has been processed for  geocoding. Address Locators  can only be created in  ArcCatalog. 

· Open ArcCatalog

· Double-Click Address Locator in left side tree window –description appears on right

· Double click Create New Address Locator in in left side tree window

· Create New Address Locator window opens

· Select US Streets (file)   and click OK

· New US Streets (File) Address Locator dialog box opens


· On Name line enter: Plano_03_US_Streets  or similar

· Under the Primary Table tab, click browse button at the end of Reference data box

· Navigate to the folder containing the trans.shp file 

--at home:  wherever you placed the data for Exercise 1

--In the lab: C:\USR\YOUR_INITIALS\            (if you copied trans.shp there)

--on the P: drive: P:\briggs\g6381\avintro\     

· Select trans.shp file

· Fields should fill in as follows. Bold fields are required. Fields in trans file are automatically recognized ‘cos it is a standard Tiger file from Census Bureau.

House from Left  
L_ADD_FROM

House to Left

L_ADD_TO

House from Right
R_ADD_FROM

House to Right

R_ADD_TO

Prefix Direction

PRE_DIR

Prefix Type

<none>

Street Name

STREET_NAM

Street Type

STREET_TYP

Suffix Direction

<none>


Click OK button to create the service
Once the address locator  has been created in ArcCatalog, you can geocode in ArcCatalog, or add the service to ArcMap (see section 13) to  geocode in ArcMap. 
Do not move the street base file once the locator is created otherwise it will not work anymore (or  you will have to re-direct the locator to the new location of the street file).

Note: when adding the service to ArcMap, “look in” the Address Locators “folder” at the bottom of the tree, not the folder containing trans.shp.
If you need to locate the actual physical  “address locator”  file (to make available on a network drive, for example), it is located in  C:\Documents and Settings\userID\Application Data\ESRI\Locators.
You may need to modify the options in Windows Explorer to see this folder; go to

   Windows Explorer>Tools>Folder Options> View tab and click  button by Show hidden files and folders 

Remember, the locator  file  contains pointers to the street network file used to create the address locator (trans.shp in our case)  so this file must be available also.
23. Using the Green Hall Computer labs (3.206, 3.602)

23.1  To logon to the machines, use your UTD netid and associated password, with Domain campus

   If you do not yet have your netid,  have forgotten the password, or need to reactivate an old account:

  
Logon using:   Userid:  netid   Password:  leave blank   Domain:   campus

This should take you automatically  to https://netid.utdallas.edu/
Choose the appropriate option (e.g. Setup a new UTD computer account) and follow the directions.
              Logoff, and after a few minutes you should be able to logon using your  netid and password

       23.2  Generic logon—use when all else fails!  UserId: sslab  Password: utdallas  Domain: this computer



There is no access to network drives (e.g.P:\). 

Download files needed for exercises from web:                                          

         http://www.utdallas.edu/~briggs/poec6381.html
       23.3  Drive Mappings

       There should be an automatic mapping to the  P:\   (public) drive for access to class files at:



P:\briggs\g6381

                     There should also be an automatic mapping to the H:\  (home) drive where you can save your files.



Space is limited, so  consider using a flash drive instead,  then you can also take files home.


             If this mapping is not available, you can set it yourself as follows (for students):


      Open MS  Explorer (right click on Start and select Explore)




Select Tools/Map Network Drive





Drive:  select H





Folder:   \\olympus\your netid
24. Documentation and Incompatibilities between ArcGIS 9.1 and 9.2 
The text (Gorr and Kurland) contains a copy of ArcGIS 9.1. We are using 9.2 in the lab.

Map documents (.mxd files) saved in 9.2 (in the lab) cannot be read by 9.1 (at home) unless you: 
use Save a copy
    and in Save as type   box you select ArcMap 9.0/9.1 document 

Another quirk is that, if you have an old version map document, which you want to read in 9.2, start ArcMap first, then use File/Open to access the document.  Do not simply double click the map document in, for example, Windows Explorer to open it since you may then encounter problems accessing ArcToolbox

Geodatabases are not compatible between 9.1 and 9.2.   Since we will be using shapefiles in this class, this is less of a problem. However, if you use a geodatabase:

--geodatabases created in 9.2 cannot be read by 9.1 (there is no “Save as type 9.1” option as with .mxd)

--you can read and modify 9.1 geodatabases with 9.2

--if you modify a 9.1 geodatabase with 9.2, and then try to read it again with 9.1, it may crash

--you can upgrade an earlier version geodatabase to the latest (9.2) version by right clicking the geodatabase in ArcCatalog (or ArcMap, I think), selecting Properties, and under General tab, click update button

A complete set of documentation for 9.1 is available on the P:\ drive in the lab at:


P:\ArcGIS_9-Help\ESRI_Library_9
Differences between 9.1 and 9.1 are documented at:

http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=welcome
A  .pdf file containing similar information is available at:

http://webhelp.esri.com/arcgisdesktop/9.2/pdf/Whats_New_In_ArcGIS_92.pdf
This has also been downloaded to the P:\ drive. 
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